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READ ME FIRST 
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In case you're not familiar with the terminology, 
Read Me First is quite often the name given to a 
computer file that contains important information 
for people to know prior to using an application. 

This section contains some important information to 
help you use this book so we thought we'd start 
with a Read Me First section. 

 

What skills and knowledge 
you will acquire... 

The skills and knowledge acquired in Microsoft Excel 2016 - More 
Functions are sufficient to be able to use and operate the software 
effectively. 

What you'll need to know 
before beginning this 
course... 

Microsoft Excel 2016 - More Functions assumes little or no knowledge of 
the software. However, it would be beneficial to have a general 
understanding of personal computers and the Windows operating system 
environment. 

 

The objectives of this guide… At the completion of this course you should be able to: 

use a variety of statistical functions 

use logical functions to test whether a statement is true or false 

create and use defined names in a workbook 

use a range of lookup and reference functions 

use a range of information functions to test worksheet data 

What you get in a chapter... Each chapter begins with a summary page listing the topics covered in 
that chapter. The chapter then consists of single-page topic sheets 
pertaining to the theme of the chapter. 

What you'll need to have 
before commencing this 
course... 

Many of the topics in this learning guide require you to open an existing 
file with data in it. These files can be obtained from your instructor and 

need the product code for this course which is ExcelMoreFunctions. 

As you work through this 
guide… 

It is strongly recommended that you close all open files, if any, prior to 
commencing each new chapter in this learning guide. Each chapter, 
where relevant, has its own set of exercise files and any from a previous 
chapter are no longer required.  

Where to from here... Have a look at the next page which explains how a topic page works, 
ensure that you have access to the exercise files (see above), and you're 
ready to make a start. 
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The majority of this book comprises single-page 
topic sheets. There are two types of topic sheets: 
task and reference. The layout of both is similar 
– an overview at the top, detail in the centre and 

additional reference (optional) material at the 
bottom. Task sheets contain a Try This Yourself 
step-by-step exercise panel in the detail area as 
shown below. 

 
Topic name 

 
General topic overview provides an introduction to the topic 

 
Try This Yourself (Task-based topic sheets) is a detailed step-by-step practice 
exercise for you to work through. In Reference topic sheets this is usually replaced 
by a box with reference information. 

 
In Task topic sheets screen shots and graphics provide a visual clue as to what 
will happen when you work through the Try This Yourself practice exercise. In 
Reference topic sheets the screen shots and graphics are used to visually 
represent information and concepts. 

 
The For Your Reference (optional) element provides a quick summary of the steps 
required to perform a task. These usually only appear in Task-based topic sheets. 

 
The Handy To Know (optional) element provides additional information such as 
alternate ways of accomplishing a task or further information providing handy tips.  

 

1 

2 

3 

4 
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WORKING WITH TOPIC SHEETS 
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CHAPTER 1 STATISTICAL FUNCTIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of statistical functions 

 learn how to use the status bar to view statistics 

 learn how to count cells using functions 

 learn how to count empty cells in a range 

 learn how to count conditionally 

 learn how to use the MODE function 

 learn how to use the MEDIAN function 

 learn how to use the LARGE and SMALL functions 

 learn how to estimate the standard deviation 

 learn how to use the VAR function. 

Excel contains a large number of statistical functions. These can be 
used to perform relatively simple operations such as summing, 
averaging and finding minimum and maximum values. 

They also allow you to perform standard statistical operations such 
as calculating standard deviation, variance, the median and the like. 

INFOCUS 
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UNDERSTANDING STATISTICAL FUNCTIONS 
 

 

 

 

  

Statistical functions range from the simple SUM 
to highly specialised functions for scientific, 
engineering and medical applications. In all there 
are 98 statistical functions listed in Excel. For 

reference purposes only, the statistical functions 
are listed below.  
 

AVEDEV F.DIST LOGEST RANK.AVG 

AVERAGE F.DIST.RT LOGNORM.DIST RANK.EQ 

AVERAGEA F.INV LOGNORM.INV RSQ 

AVERAGEIF F.INV.RT MAX SKEW 

AVERAGEIFS F.TEST MAXA SKEW.P 

BETA.DIST FISHER MEDIAN SLOPE 

BETA.INV FISHERINV MIN SMALL 

BINOM.DIST FORECAST.ETS ** MINA STANDARDIZE 

BINOM.DIST.RANGE FORECAST.ETS.CONFINT ** MODE.MULT STDEV.P 

BINOM.INV FORECAST.ETS.SEASONALITY ** MODE.SNGL STDEV.S 

CHISQ.DIST FORECAST.ETS.STAT ** NEGBINOM.DIST STDEVA 

CHISQ.DIST.RT FORECAST.LINEAR ** NORM.DIST STDEVPA 

CHISQ.INV FREQUENCY NORM.INV STEYX 

CHISQ.INV.RT GAMMA NORM.S.DIST T.DIST 

CHISQ.TEST GAMMA.DIST NORM.S.INV T.DIST.2T 

CONFIDENCE.NORM GAMMA.INV PEARSON T.DIST.RT 

CONFIDENCE.T GAMMALN PERCENTILE.EXC T.INV 

CORREL GAMMALN.PRECISE PERCENTILE.INC T.INV.2T 

COUNT GAUSS PERCENTRANK.EXC T.TEST 

COUNTA GEOMEAN PERCENTRANK.INC TREND 

COUNTBLANK GROWTH PERMUT VAR.P 

COUNTIF HARMEAN PERMUTATIONA VAR.S 

COUNTIFS HYPGEOM.DIST POISSON.DIST VARA 

COVARIANCE.P INTERCEPT PHI VARPA 

COVARIANCE.S KURT PROB WEIBULL.DIST 

DEVSQ LARGE QUARTILE.EXC Z.TEST 

EXPON.DIST LINEST QUARTILE.INC  

** Statistical functions new to Microsoft Excel 2016. 

Statistical Functions List 

To view the list of available financial functions, click on the Formulas tab, then click on More Functions in the 
Function Library group and point to Statistical. This will display a sub-menu which lists the statistical 
functions from A-Z. Clicking on a function will open the Function Arguments dialog box. To view more 
information on the function you can click on Help on this function in the bottom left corner of the dialog box. 
This will open the Excel Help window with detailed and specific information on the function. 
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STATUS BAR STATISTICS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

An area of statistical information that is often 
overlooked is the status bar. The status bar can 
be configured to perform statistical analysis on 
cells and ranges that are selected in the 

worksheet or workbook. This means you can 
access statistical information quickly without having 
to create formulas especially for the purpose. It is 
ideal for cross-checking totals and other results. 
 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this 
exercise you MUST open 
the file Statistical 
Functions_1.xlsx... 

 
On the Sheet1 
worksheet, select the 
range B5:B10 

 
Read the statistical 
calculations that should 
appear in the status bar at 
the bottom of the screen 

This is a very quick and 
easy way to view the 
Sum, Average and Count 
statistics for selected 
cells... 

 
Right-click on the status 
bar to display the shortcut 
menu 

There are a number of 
options that you can hide 
or display on the status 
bar... 

 
Click on Count so it 
appears without a tick, 
then press  to hide the 

menu 

The Count statistics no 
longer appear on the 
status bar... 

 
Repeat steps 3 and 4 to 
display Count on the 
status bar once more 

 

2 

3 

For Your Reference… 

To use the status bar calculations: 

1. Select the cells 

2. Read the figure shown in the status bar 

3. Right-click on the status bar to display a 
shortcut menu of options  

4. Click on an option to show/hide it 

  

Handy to Know… 

 The other statistical function options 
available in the Status bar shortcut menu 
are: Numerical Count (COUNT), Minimum 
(MIN) and Maximum (MAX). 

 The Count (COUNTA) option shown in the 
status bar, counts the number of cells that 
contain a value (be it numerical or text). 

4 
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USING COUNT AND COUNTA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file Statistical 
Functions_2.xlsx... 

 
Click in cell B13, then type 
=COUNT(B5:N5) 

 
Press  to complete the 

formula 

 
Click in cell C13, then type 
=COUNTA(B5:N5) 

 
Press  to complete the 

formula 

Currently, both of the results 
are the same – let’s delete a 
cell in the range... 

 
Click in cell C5, then press 

 

Both Count formulas return 
12 because empty cells are 
not included in either 
calculation... 

 
Click in cell F5, type Closed, 

then press  

Now the formulas return 
different values, as text is 
only counted by the COUNTA 
function... 

 
Select B13:C13, then double-
click on the fill handle to copy 
the formula down and across 
to cell C18 

 

Two of the main functions for counting cells are 
COUNT and COUNTA. COUNT counts the 
number of values in a range excluding text while 
COUNTA counts the number of values in a range 

including text. For example, if the range is A1:A10 
and cell A5 contains the text ‘On Hold”, COUNT will 
count 9 cells (as it won’t count cell A5), while 
COUNTA will count 10 (as it will count cell A5).  

4 

6 

7 

For Your Reference… 

To use the COUNT function: 

1. Click in a cell, then type =COUNT(range) 

2. Press   

To use the COUNTA function: 

1. Click in a cell, then type =COUNTA(range) 

2. Press   

Handy to Know… 

 A blank cell is seen as a text value and will 
therefore be included by COUNTA but not 
COUNT. 
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USING COUNTBLANK 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Statistical 
Functions_3.xlsx... 

 
Click in cell D13, then 
type 
=COUNTBLANK(B5:N5
) 

 
Press  to complete 

the formula 

The result 1 will be 
displayed – this is 
because there is no 
value in cell C5... 

 
Click in cell D13, then 
double-click on the fill 
handle to copy the 
formula down to cell 
D18 

 

For Your Reference… 

To use the COUNTBLANK function: 

1. Click in a cell 

2. Type =COUNTBLANK(range) 

3. Press   

Handy to Know… 

 When using the COUNTBLANK function, 
cells with zero values are not counted. 

The COUNTBLANK function can be used to 
count the number of cells in a range that contain 
no information – that is, the number of empty 
cells. COUNTBLANK could be used, for 

example, in a data list that records fees paid, to 
indicate the number of unpaid fees. Those cells 
that do not contain a paid fee value will be blank 
and therefore counted in the calculation. 
 

1 

2 

3 
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USING COUNTIF 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Statistical 
Functions_4.xlsx... 

 
Click in cell E13, then 
type 
=COUNTIF(B5:N5,">300
00") 

In this example we will 
count only the Tuesdays 
where the takings 
exceeded $30,000... 

 
Press  to complete 

the formula 

The number of days is 
2... 

 
Click in cell E13, then 
double-click on the fill 
handle to copy the 
formula down to cell E18 

 

You might need to count cells that contain a 
specific value or conform to specific guidelines, 
such as how many cells have a value greater 
than 10, or hold a particular label. This type of 

counting can be achieved with the COUNTIF 
function. This function counts the number of cells in 
the range that satisfy the criteria. The criteria can 
take the form of a number, text or an expression.  

1 

2 

For Your Reference… 

To use the COUNTIF function: 

1. Click in a cell 

2. Type =COUNTIF(range, criteria) 

Handy to Know… 

 If you wish to count cells that contain a 
specific value or conform to specific 
guidelines across multiple ranges, you can 

use the COUNTIFS function. 

3 
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USING MODE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the 
file Statistical 
Functions_5.xlsx... 

 
Click in cell F13 and 
type =MODE(B5:N5) 

 
Press  to 

complete the formula 

The error #N/A will 
appear as there are 
no repeating values... 

 
Click in cell C5 and 
type 17200, then 

press  

The Mode value now 
changes to 17200 as 
the value appears 
twice in the range 
indicated... 

 
Click in cell F13 and 
double-click on the fill 
handle to copy the 
formula down to cell 
F18 

All of the remaining 
Mode values will be 
represented by the 
error #N/A 

              

The MODE function returns the value that occurs 
most frequently within a given range. The value 
must occur more than once or the MODE 
function will return the error #N/A meaning that it 

is not applicable. This might be useful if you are 
analysing test scores and are interested to know 
which score was the most frequently achieved. 
 

2 

3 

For Your Reference… 

To use the MODE function: 

1. Click in a cell 

2. Type =MODE(range) 

3. Press   

 

Handy to Know… 

 When using the MODE function, any cells in 
the selected range that do not contain values 
are ignored. However, cells that contain a 
zero (0) value are included. 

 The related functions MEDIAN and 
AVERAGE are also commonly used, along 
with MODE, when working with scores. 

4 
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USING MEDIAN 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the 
file Statistical 
Functions_6.xlsx... 

 
Click in cell G13 and 
type =MEDIAN(B5:N5) 

 
Press  to complete 

the formula 

The value 20650.5 is 
returned. As there are 
12 entries in the range 
(i.e. an even number, 
since one cell contains 
text), Excel averages 
the two numbers in the 
centre of the numbers, 
arranged from highest 
to lowest. Those two 
numbers would be 
20608 and 20693... 

 
Click in cell G13, then 
double-click on the fill 
handle to copy the 
formula down to cell 
G18 

 

The MEDIAN function returns the number that is 
in the middle of a selected range of values when 
arranged in ascending or descending order. That 
is, the point at which exactly half of the numbers 

in the range are lower and half of the numbers in 
the range are higher. This might be useful, for 
instance, when dealing with scores to locate the 
midway point. 
 

1 

2 

For Your Reference… 

To use the MEDIAN function: 

1. Click in a cell and type =MEDIAN(range) 

2. Press   

 

  

Handy to Know… 

 When using the MEDIAN function, if there is 
an even number of numbers in the selected 
range, the function will calculate the average 
of the two numbers in the middle of that 
range. 

3 
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USING LARGE AND SMALL 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file Statistical 
Functions_7.xlsx... 

 
Click in cell H13, then type 
=LARGE(B5:N5,1) 

This will locate the highest 
sale recorded for Tuesdays... 

 
Press  to complete the 

formula 

The value 32991 is returned. 
But what if we want the 
second highest value? 

 
Click in cell H13, double-click 
on the 1 in the Formula Bar, 
then type 2 

 
Press   

Notice the value 32182 is 
displayed… 

 
Click in cell H13, then 
double-click on the fill handle 
to copy the formula to cell 
H18 

Now for the lowest values... 

 
Click in cell I13, type 
=SMALL(B5:N5,3), then 

press  to return the third 

lowest value 

 
Repeat step 5 to copy the 
formula from cell I13 down to 
cell I18 

 

For Your Reference… 

To use the LARGE or SMALL function: 

1. Click in a cell 

2. Type =LARGE(range,# largest value 
within range), or 

 Type =SMALL(range, # smallest value 
within range) 

 

The LARGE and SMALL functions enable you to 
locate values based on their relative standing 
within the selected range. For instance, if you 
want to find the second highest value, you could 

use the LARGE function. This might be useful in a 
data list recording sales, to locate the first, second 
and third highest sales in a month. The SMALL 
function enables you to locate the smallest values. 
 

2 

Handy to Know… 

 When using the LARGE and SMALL 
functions, if the argument k is less than or 
equal to zero, or greater than the number of 
selected cells, a #NUM! error is returned. 

4 

7 



Microsoft Excel 2016 - More Functions 

© 2017 The University of Nottingham Page 10 Chapter 1 - Statistical Functions 

USING STDEV 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
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e
 

Continue using the previous 
file with this exercise, or 
open the file Statistical 
Functions_8.xlsx... 

 
Click in cell J13, then type 
=STDEV.S(B5:N5) 

 
Press  to complete the 

formula 

The STDEV.S function 
should only be used with a 
sample of the population. If 
your data includes the entire 
population, as is the case 
with our worksheet, you 
should use STDEV.P... 

 
Click in cell J13, then modify 
the formula in the Formula 
Bar so that it reads 
=STDEV.P(B5:N5) 

 
Press  to complete the 

formula and see the revised 
calculation 

 
Click in cell J13, then 
double-click on the fill handle 
to copy the formula down to  
cell J18 

 

The standard deviation measures how widely 
values are dispersed from the mean (average) 
based on a sample (STDEV.S()) or on the entire 
population (STDEV.P()). The standard deviation 

is calculated using the n-1 method as follows: 

2 

3 

For Your Reference… 

To use the STDEV function for a sample: 

 Click in a cell and type =STDEV.S(range) 

To use the STDEV function for an entire 
population: 

 Click in a cell and type =STDEV.P(range) 

 

 

Handy to Know… 

 The STDEVA function also estimates the 
standard deviation based on a sample, but 
includes text and logical values (TRUE and 
FALSE – where TRUE has a value of 1 and 
text and FALSE have a value of 0). 

 

5 
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USING VAR 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the 
file Statistical 
Functions_9.xlsx... 

 
Click on the Variance 
worksheet tab to make 
this the active 
worksheet 

Variance is commonly 
applied to test scores 
to determine how 
much the values vary 
from the mean... 

 
Click in cell D21, then 
type =VAR.S(A4:A20) 

 
Press  to 

complete the formula 

 

The VAR.S function is used to calculate the 
variance of numbers from the mean within a 
sample range. The larger the variance, the more 
the values vary from the mean. The VAR function 

is often used by statisticians along with the STDEV 
function to analyse a list of numbers. Although it is 
possible to manually calculate variance, it is a very 
lengthy process – the VAR function is instant. 
 

2 

3 

For Your Reference… 

To use the VAR function for a sample: 

1. Click in a cell  

2. Type =VAR.S(range) 

 

  

Handy to Know… 

 The variance is a squared number, so it can 
prove tricky to interpret this value in relation 
to the mean. Because of this, statisticians 
calculate the square root of the variance and 
this is called the standard deviation. 
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NOTES: 
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CHAPTER 2 LOGICAL FUNCTIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of logical functions 

 learn how to use IF with text 

 learn how to use IF with numbers 

 learn how to nest IF functions 

 learn how to use IFERROR 

 learn how to use TRUE and FALSE 

 learn how to use the AND function 

 learn how to use the OR function 

 learn how to use the NOT function. 

Logical functions are used in worksheets to test whether a situation 
is true or false. Depending on the result of that test, you can then 
choose to perform an action such as display information, perform 
different calculations or perform further tests. 

INFOCUS 
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UNDERSTANDING LOGICAL FUNCTIONS 
 

 

 

 

  

 

Logical functions provide decision-making tools 
for information in a spreadsheet. They allow you 
to look at the contents of a cell or to perform a 
calculation, and then test that result against a 

required figure or value. You can then use the IF 
logical function to determine which calculation to 
perform or action to take depending on the 
outcome of the test. Here are some examples. 

The IF Function 

The IF function is the key logical function used for decision making. It takes the format: 

=IF(condition, true, false) 

For example, you could use the following formula: 

=IF(B2 > 400, “High”, “Low”) where, 

B2 > 400 is the condition being tested 
(this could be translated as “Is the value in cell B2 greater than 400?”) 

“High” is the text to display if B2 is greater than 400 (the result of the test is yes or TRUE) 

“Low” is the text to display if B2 is less than or equal to 400 (the result of the test is no or 
FALSE) 

The AND Function 

The AND function is used to compare more than one condition. It returns TRUE only if all of the 
conditions are met, and takes the format: 

=AND(condition1, condition2,…) 

For example, you could use the following formula: 

=AND(B2 > 400, C2 < 300) where, 

B2 > 400 is the first condition being tested 

C2 < 300 is the second condition being tested 

This will only return the result TRUE if the value in cell B2 is greater than 400 and the value in cell C2 is 
less than 300. In all other situations, the result will be FALSE. 

The OR Function 

The OR function is also used to compare more than one condition. It returns TRUE if any of the 
conditions are met, and takes the format: 

=OR(condition1, condition2,…) 

For example, you could use the following formula: 

=OR(B2 > 400, C2 < 300) where, 

B2 > 400 is the first condition being tested 

C2 < 300 is the second condition being tested 

This will return the result TRUE if either the value in cell B2 is greater than 400 or the value in cell C2 is 
less than 300. The result will be FALSE only if none of the conditions are met. 
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USING IF WITH TEXT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The IF function can be used to display different 
information depending on the outcome of a 
conditional test. The resulting text will appear in 
the cell where the formula containing the IF 

function resides. In this example, the IF function is 
used to indicate whether adjacent sales figures 
meet or exceed a specified target. This makes 
identifying successful sales people far easier. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file 
Logical Functions_1.xlsx... 

 
Click on the IF Function 
worksheet tab  

 
Click in cell D7, then type: 

=IF(C7>$E$2,"Exceeded 
Target","Below Target") 

 
Press  to complete the 

formula 

 
Click in cell D7, then  
double-click on the fill 
handle to copy the formula 
down the column 

Notice that the result for 
Jerry Hancock is Below 
Target even though he 
achieved 34,000. This is 
because the condition 
requires the sales to be 
greater than the target. 
We’ll change it to greater 
than or equal to the target... 

 
Click in cell D7, then click in 
the Formula Bar 
immediately to the right of > 

 
Type =, then press  

 
Click in cell D7, then 
double -click on the fill 
handle to copy the formula 
down the column 

 

2 

4 

For Your Reference… 

To use the IF function to create decision 
making: 

=IF(test, value_if_true, value_if_false) 

This function performs a test, then if the result 
is true, uses the entry in the position true. If the 

result is not true, the entry for false is used. 

7 

Handy to Know… 

 If you only want text to appear if the result is 
true, you can enter "" (two double quotes) in 
the position for false. For example, 
=IF(C7>=$E$2,"Exceeded Target","") will 
only display text if the target was met or 
exceeded. 
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USING IF WITH NUMBERS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

One of the most common uses of the IF function 
is to perform numerical computations based on 
the outcome of the condition test. This is 
achieved by putting formulas that would normally 

be used to calculate values in place of the true and 
false components in the function. You can also use 
this structure to show a specific value according to 
the result of the condition test. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the 
previous file with this 
exercise, or open the file 
Logical Functions_2.xlsx... 

 
Ensure the IF Function 
worksheet tab is selected, 
then click in cell E7 

 
Type: 

=IF(C7>=$E$2,(C7-
$E$2)*$E$3,0) 

This formula tests to see if 
the monthly sales figure is 
greater than or equal to 
the target. If it is, then the 
difference between the 
monthly sales and target 
is calculated and this 
difference is multiplied by 
the 5% commission. If the 
monthly sales isn‘t greater 
than or equal to the target, 
a zero commission is 
applicable... 

 
Press  to complete 

the formula 

 
Click in cell E7, then 
double-click on the fill 
handle to copy the 
formula down 

We formatted column E 
before you opened the 
workbook – that’s why the 
dash symbol appears 
instead of zero where no 
commission is to be paid 

 

2 

3 

For Your Reference… 

To use the IF function to create decision making 
with numeric values: 

=IF(test, value_if_true, value_if_false) 

The true-value and the false-value both need to 
be numeric here. They could be a value, a cell 
reference, or even another (nested) formula. 

Handy to Know… 

 The true_value and false_value in an IF 
function can be mixed with one text and the 
other a numeric.  

4 
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NESTING IF FUNCTIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you need to make more than one decision 
before calculating an answer, you can nest or 
embed an IF function inside another IF function. 
For example, you can use an IF function in place 

of the true component of the IF function. If the 
result of the first condition test is true, the second 
condition will be tested. This structure provides for 
three alternative outcomes instead of two. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file Logical 
Functions_3.xlsx... 

 
Double-click in cell E7 to 
display the formula 

 
Click after the first equal sign, 
type IF(C7>=(2*$E$2), then 
press  +  to create a 

new line  

You don’t have to put a new 
line in the Formula Bar for the 
formula to work but it does 
make it easier to work with 
complex formulas… 

 
Type (C7-$E$2)*(2*$E$3),  

then press  +  to 

create a new line 

 
Click immediately after the first 
comma on the last line, then 
press  +  to create a 

new line 

 
Again, click immediately after 
the first comma on the last 
line, then press  +  

Your formula is now divided 
into components. Let’s 
complete the formula… 

 
Press  to move to the end 

of the formula, then type ) 

 
Press , click in cell E7 

then click and drag the fill 
handle down to cell E15 

 

5 

7 

For Your Reference… 

To nest one IF inside another: 

1. Double-click on the formula cell 

2. Click at the desired location in the formula 
either in the Formula bar or in the cell being 
edited 

3. Type the additional requirements 

Handy to Know… 

 When you create nested formulas, Excel will 
colour-code the paired brackets to make it 
easier to see what you are doing. The 
outside brackets are coloured black. 

 You can nest any function within another 
function, but plan carefully. 
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USING IFERROR 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the 
file Logical 
Functions_4.xlsx... 

 
Click on the IFERROR 
Function worksheet 
tab, then click in cell E7 

 
Type the following 

=IFERROR(C7/D7, 
"First Year") 

 
Press  

 
Click in cell E7, then 
double-click on the fill 
handle to copy the 
formula down the 
column 

Instead of giving an 
error where the divisor 
is zero, Excel displays 
the text “First Year” in 
the cell 

 

For Your Reference… 

IFERROR(calculation, error_value) 

This function performs the calculation and if 
there are no errors, displays the result of the 
calculation. If an error does occur, it displays the 
error_value. 

IFERROR is used to trap errors that may occur 
as the result of a calculation and then display 
alternative text or values. For example, if you 
divide a number by zero, Excel will normally 

return the message #DIV/0! which can be a bit 
alarming for novice users. IFERROR tests a 
calculation to see if it works and, if so, performs the 
calculation. If not, it displays an alternative. 
 

2 

4 

Handy to Know… 

 When using IFERROR you can use text as 
the entry to be displayed if an error is 
located, but you could just as easily display 
nothing using "" (two double quotes) or 
perform an alternative calculation. 
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USING TRUE AND FALSE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TRUE and FALSE are logical values. The result 
of a logical test is either true or false and Excel 
allows you to enter these values in cells or test 
for them in functions. TRUE and FALSE can be 

entered as values, which are TRUE and FALSE, or 
as formulas with no parameters, which are 
=TRUE() and =FALSE(). The value TRUE and the 
formula =TRUE() are treated as identical by Excel. 
 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the 
file Logical 
Functions_5.xlsx... 

 
Click on the AND 
Function worksheet 
tab, then click in cell D7 

 
Type the TRUE and 
FALSE entries in the 
column as shown 

 
Click in cell E7, then  
type =IF(C7>=$E$2, 
IF(D7=TRUE, 
(C7-$E$2)*$E$3,0),0) 

 
Press  

 
Click in cell E7, then 
double-click on the fill 
handle to copy the 
formula down the 
column 

 

2 

For Your Reference… 

TRUE 

The logical value TRUE 

FALSE 

The logical value FALSE 

 

Handy to Know… 

 TRUE is used to make formulas more 
readable. For instance, you could write the 
formula, =IF(C7>=$E$2, IF(D7=TRUE, 
(C7-$E$2)*$E$3,0),0) as 
=IF(C7>=$E$2,IF(D7,(C7-$E$2)*$E$3,0),0), 
however including TRUE in the first example 
makes the formula easier to understand. 

3 

5 



Microsoft Excel 2016 - More Functions 

© 2017 The University of Nottingham Page 20 Chapter 2 - Logical Functions 

USING AND 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Logical 
Functions_6.xlsx... 

 
Ensure the AND 
Function worksheet is 
selected, click in cell E7, 
then type: 
=AND(C7>=$E$2,D7=T
RUE) 

 
Press   

The result will be TRUE 
because both conditions 
are satisfied. Now to add 
the IF function... 

 
Double-click in cell E7, 
click after the first equal 
sign, then type IF( 

 
Press  to move to the 

end of the formula, type , 
(comma), then press  

+  to create a new 

line 

 
Type (C7-$E$2)*$E$3,0) 

 
Press  

 
Click in cell E7, then 
double-click on the fill 
handle to copy the 
formula down the 
column 

 

The AND function is used to compare the results 
of more than one condition test. It ensures that a 
calculation will not be performed unless all of the 
specified conditions are met. In other words, the 

first and second and third (and so on) conditions 
must all be true before AND returns the value true. 
This is ideal to use with the IF function to test for a 
collection of conditions. 
 

1 

5 

For Your Reference… 

AND(logical1, logical2,…) 

This function tests the logical value of each 
entry e.g. logical1. If they are all true, it will 
return the value TRUE. If any one of them is 
false, the function will return FALSE. 

 

Handy to Know… 

 A condition in an AND function can simply be 
a reference to a cell holding a logical value 
(that is, TRUE or FALSE). For example, 
=AND(B2,C2) will return the value FALSE if  
cell B2 and/or cell C2 contain the text 
FALSE. 

7 
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USING OR 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Logical 
Functions_7.xlsx... 

 
Click on the OR 
Function worksheet tab, 
then click in cell E7 

 
Type 

=OR(D7="Gold",D7="Sil
ver") 

 
Press   

The result will be TRUE 
because both conditions 
are satisfied. Now to add 
the IF function… 

 
Double-click in cell E7, 
click after the first equal 
sign, then type IF( 

 
Press  to move to the 

end of the formula, type , 

(comma), then press   

+  to create a new 

line 

 
Type (C7-$E$2)*$E$3,0) 

 
Press  

 
Click in cell E7, then 
double-click on the fill 
handle to copy the 
formula down the column 

 

For Your Reference… 

OR(logical1, logical2,…) 

This function tests the specified logical 
conditions or cell references. If any one of the 
conditions is true, it will return the value TRUE. 
If all of them are false, the function will return 
FALSE. 

 

Handy to Know… 

 If you want to find data that meets more than 
one condition you can use the AND function 
and the OR function together.  

The OR function is used to compare the results 
of more than one condition test. It will return the 
value TRUE if any of the condition tests return 
the value TRUE. It will only return the value 

FALSE if all of the condition tests return FALSE. 
The OR function is often used in conjunction with 
the IF function to test a collection of conditions, and 
is easier to work with than nested IF functions. 
 

2 

6 
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USING NOT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Logical 
Functions_8.xlsx... 

 
Ensure the OR Function 
worksheet is selected, 
double-click in cell E7, 
then click before OR 

 
Press  twice to 

remove the OR function, 
then change the formula 
so it reads 

=IF("),C7-$E$2)*$E$3,0) 

 
Add the NOT function so 
that the formula now 
reads 

=IF(NOT(D7="Bronze"),
(C7-$E$2)*$E$3,0) 

This excludes any of the 
Bronze sales agents, 
therefore selecting Silver 
and Gold… 

 
Press   

 
Click in cell E7, then 
double-click on the fill 
handle to copy the 
formula down the column 

The results are the 
same, we’ve just tested 
the contents of the cells 
in a slightly different way 

 

Sometimes the best way to get the result you 
need is to exclude the values that you don’t want, 
rather than testing for the values that you do. 
The NOT function is perfect for this situation, 

returning the logical opposite of the condition test. If 
the condition test returns the value TRUE, the NOT 
function will return the value FALSE. This can also 
be used to great effect with the IF function. 
 

2 

For Your Reference… 

NOT(logical) 

This function tests the specified logical 
condition or contents of a cell. If the condition is 
true, it will return the value FALSE. If the 
condition is false, the function will return TRUE. 

 

Handy to Know… 

 If you want to pay commission to Gold and 
Silver agents only if they exceed the target 
(to avoid paying negative commission), you 
can use: 

=IF(AND(C7>=$E$2, 

NOT(D7=”Bronze”)),(C7-$E$2)*$E$3,0) 

3 
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CHAPTER 3 DEFINED NAMES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of how and where defined names 
are used 

 learn how to create defined names using existing text 
labels 

 learn how to use Defined Names in new formulas 

 learn how to apply names to existing formulas 

 learn how to create range names using the Name box 

 learn how to use defined names to select and navigate to 
ranges 

 learn how to paste defined names into formulas 

 learn how to create constants in Excel 

 learn how to create names from a selection in the 
worksheet 

 learn how to create defined names that are scoped to a 
specific worksheet 

 learn how to use the defined name Name Manager 

 learn how to paste a list of defined names into the 
worksheet. 

When inserting data in a worksheet that you will refer to in the 
future, it can be difficult to find a way of remembering where that 
data is contained. Fortunately, you can assign names to cells or 
ranges to make it easier to find or refer to them later on. These are 
called Defined Names. For instance, you may have entered budget 
assumptions for the previous year in the range A4:D4 in the 
Forecast worksheet. Rather than having to remember the range, 
you can assign a logical name to the data, such as Assumptions. 
These names can be used instead if cryptic range addresses for 
selecting and working on the data located in a range. The names 
can also be used in formulas to make them more readable and 
understandable. 

INFOCUS 
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UNDERSTANDING DEFINED NAMES 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

  

Defined names are labels that you can assign to 
a cell or range in a worksheet. They are designed 
to make working with that cell or range easier. 
You can use a name in a formula instead of a 

cryptic range address – for example, =SUM(Qtr1) 
is a lot easier to understand than =SUM(A5:A62). 
Names can also be used to select ranges for 
printing, graphing, copying and the like. 

Names Defined From Labels 

The term label usually refers to text that you have typed in a cell. If the text appears next to a continuous 
list of values, Excel can see the label as a ‘tag’ that represents that range of values. The label can then 
be used in formulas instead of direct cell references. If you have used numbers as ‘labels’, such as the 
year 2016, Excel allows you to define these as labels too. 

 
Here the label Australia, typed originally in cell 
B5, is being used as the defined name for the 
vertical range B6:B10. You can see it in the 
Name box at the top left above column A. 

Similarly, the label Year 1, typed originally in 
cell A6, could be used as the defined name for 
the horizontal range B6:D6. 

Interestingly, Excel allows more than one 
defined name to be assigned to a cell, a range, 
or overlap another named area. 

Names Defined By Typing 

If you want to create a tag that refers to a range of cells holding values and text, or that you can use in 
formulas on other worksheets, you can type your own defined name. These are the same as labels 
except that the name has to be specified against a particular range, and does not usually appear in the 
worksheet. Names can be used to refer to cells in other worksheets or in other workbooks. They can 
even be used to represent a fixed value (referred to as a constant) rather than a range of cells. For 
example, if you need to use a constant value in your calculations, but don’t want the value to appear in 
the worksheet in case it is accidentally changed, you can define a name and assign it a value. For 
example, Tax could represent the value 10%. 

 
Providing the label has been applied to a 
formula, any formula that encompasses the 
exact area of a defined name will appear in the 
formula bar using the name in lieu of the range 
or cell address. Notice that the formula here 
reads =SUM(Australia) rather than 
=SUM(B6:B10). 

The Name box (at the top left) shows that cell 
B12, which contains the formula, has been 
named as TotalForAustralia – this doesn’t 
appear as a label in the worksheet and has 
been typed in as a defined name. 

Rules To Follow 

There are two important rules to follow when defining names: 

1. You can only use letters of the alphabet, numbers, and the underscore character ( _ ) in names. 
Spaces and other special characters such as &, * or % are not allowed. 

2. Names must not begin with a number. Use a letter or an underscore as the first character of a 
name; for example, Year2016 or _2016. 
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DEFINING NAMES FROM WORKSHEET LABELS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Excel assumes that there will be many occasions 
where the text typed in a worksheet describes the 
values to which it is adjacent. If you have typed a 
text label next to a continuous list of values, you 

can use it as a tag to refer to the values. This can 
be done using the Define Name command in the 
Defined Names group on the Formulas tab. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file 
Defined Names_1.xlsx... 

 
Click on the Past 5 Years 
worksheet tab and spend a 
few moments studying the 
data 

 
Click in cell B6, hold down 

, then click in cell B10 

to select the range B6:B10 

 
Click on the Formulas tab, 
then click on Define Name 
in the Defined Names 
group to display the New 
Name dialog box 

Notice how Excel has used 
the text label from cell B5 
as the assumed name for 
the range… 

 
Click on [OK] to accept the 
default settings 

The new name will appear 
in the Name box… 

 
Repeat the above steps 
and create the following 
names: 

Name  Range 

UK  C6:C10 
New_Zealand D6:D10 
Year_1  B6:D6 
Year_2  B7:D7 
Year_3  B8:D8 
Year_4  B9:D9 
Year_5  B10:D10 

 

2 

3 The Refers to text 
box refers to the 
location of the 
defined name. 
Notice how defined 
names are absolute 
(as indicated by 
both the worksheet 
name and the dollar 
signs). 

4 

For Your Reference… 

To define a name from a worksheet label: 

1. Select the cell or range adjacent to the label 

2. Click on the Formulas tab, then click on 
Define Name in the Defined Names group 

3. Click on [OK] 

Handy to Know… 

 If there are spaces in the labels (such as 
between words) Excel will replace these with 
an underscore character. This occurs 
because spaces are not permitted in Defined 
Names. 
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USING NAMES IN TYPED FORMULAS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file Defined 
Names_2.xlsx... 

 
Click in cell B12 

 
Type =sum(Australia)  

 
Press  

If you have typed the name 
correctly the formula will 
now display a calculated 
result as though you had 
typed the formula in the 
normal way using cell 
references. If your formula 
contains an invalid name, 
then the error #NAME? will 
appear… 

 
Type the following formulas: 

Cell Formula 

C12 =sum(UK) 
D12 =sum(New_Zealand) 

 
Click back in cell B12  

Notice how the formula 
appears in the Formula Bar 

 

Once names have been defined within a 
worksheet or workbook they can be used when 
typing formulas. Defined names are stored within 
the workbook so that when a name is typed into a 

formula Excel checks its internal listing. If the name 
is there, Excel will use it to reference the 
appropriate cells and calculate the formula. 

2 

For Your Reference… 

To use a defined name in a new formula: 

 Type the formula in the normal way and type 
the range name instead of the range address 

5 

Handy to Know… 

 If you attempt to type a name that Excel 
doesn’t recognise, the #NAME? error 
message will appear in the cell. 

 Range names are not case sensitive so you 
can type them in either uppercase or 
lowercase. 
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APPLYING NAMES TO EXISTING FORMULAS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Names are often defined within a workbook after 
many of the formulas have already been entered. 
It would be a pain to have to re-create the 
formulas using newly defined range names. 

Fortunately, Excel allows you to apply defined 
names to existing formulas without having to edit or 
re-type the formulas into the workbook. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file Defined 
Names_3.xlsx... 

 
Click in cell E6, type 
=SUM(B6:D6), then press 

 

 
Click in cell E6, then click 
and drag the fill handle to cell 
E12 

 
Point to the AutoFill icon, 
click on the drop arrow, then 
click on Fill Without 
Formatting 

 
Click on cell E11, then press 

 to delete the formula 

 
Click in cell A5, hold down 

, then click in cell E12 to 

select the range A5:E12 

 
Click on the Formulas tab, 
click on the drop arrow for 
Define Name in the Defined 
Names group, then select 
Apply Names 

 
Click on all of the names until 
they are selected, then click 
on [OK] to apply the selected 
names to formulas in the 
selected range 

 
Click on the formulas in the 
worksheet and notice how 
names have been inserted in 
lieu of cell addresses 

 

3 

6 

For Your Reference… 

To apply names to existing formulas: 

1. Select the range containing the formulas 

2. Click on the Formulas tab, click on the drop 
arrow for Define Name in the Defined 
Names group, then click on Apply Names 

3. Select the names to apply and click on [OK] 

Handy to Know… 

 The Apply Names command is also a handy 
way of refreshing range names. 

8 
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CREATING NAMES USING THE NAME BOX 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
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e
 

Continue using the 
previous file with this 
exercise, or open the file 
Defined Names_4.xlsx... 

 
Click on cell A1, hold 
down , then click in 

cell E12 to select the 
range A1:E12 

 
Click in the Name box, 
then type Last5Years 

 
Press  to create the 

name 

 
Click on the Australia 
worksheet tab, then click 
in cell B13 

 
Click in the Name box, 
type AUS_Sales, then 

press  

 
Repeat steps 4 and 5 
and create the names 
as shown 

 

Names are defined to represent individual cells, 
ranges of cells, or specific values. Names can be 
used in formulas and to re-select cells. A quick 
way to create a name for a range is by selecting 

the cell(s) and then typing the name in the Name 
box. The Name box is located below the toolbars 
and to the left of the Formula Bar. 

2 

6 

For Your Reference… 

To use the Name box to create defined names: 

1. Select the range in the worksheet to name 

2. Click in the Name box 

3. Type the desired name and press  

Handy to Know… 

 If you use the Name box and type in a name 
that already exists as a Defined Name, 
Excel will think you want to navigate to that 
range and will position the cell pointer in that 
range. Excel usually doesn’t allow duplicated 
names in a workbook. 

Worksheet Cell Name 

United Kingdom B13 UK_Sales 

New Zealand B13 NZ_Sales 

5 
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USING NAMES TO SELECT RANGES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Names can be used in a variety of ways. They 
can be used to refer to a range of cells on which 
you want to perform a calculation. You can also 
use them to reselect an area easily. This means 

that you can define ranges for printing or charting, 
for example, and return to them just by selecting 
their name. This is ideal when you need to print 
specific selections of cells. 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
Defined Names_5.xlsx... 

 
Click on the drop arrow of 
the Name box to see a list 
of names that have been 
created 

 
Click on Last5Years to 
select and move to this 
range 

This selected range could 
now be used for a variety 
of tasks including copying, 
printing, charting, etc… 

 
Click on the Name box 
drop arrow and click on 
UK_Sales 

 
Click on the Name box 
drop arrow again and click 
on Australia 

You can also use the Go 
To box and defined names 
to navigate the 
workbook… 

 
Click on the Home tab, 
click on Find & Select in 
the Editing group, then 
click on Go To to display 
the Go To dialog box 

 
Click on New_Zealand, 
then click on [OK] 

 

1 

2 

For Your Reference… 

To use defined names to select areas: 

1. Click on the Name box drop arrow  

2. Click on the desired range name 

Handy to Know… 

 Single-cell defined names are a good way of 
navigating to specific locations in large and 
complex workbooks. For example, if you 
name the top cell of your budget data 
BudgetData you can use the Name box 
drop arrow or Go To to navigate to that 
specific location. 

5 
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PASTING DEFINED NAMES INTO FORMULAS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Range names are the perfect way of making 
more complex formulas easier to comprehend. 
You can type defined names into formulas as the 
formula is created. But what happens if you are 

unsure of the defined name or its spelling? 
Fortunately, Excel provides you with a facility 
where defined names can be pasted into formulas 
directly from a list of valid names. 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
Defined Names_6.xlsx... 

 
Click on the Past 5 
years worksheet tab, 
then click in cell B10 

This is the last year of 
total sales for Australia 
and should be based on 
the total sales in the 
Australia worksheet… 

 
Click on the Formulas 
tab, click on Use in 
Formula in the Defined 
Names group, then click 
on Paste Names to 
display the Paste Name 
dialog box 

 
Click on AUS_Sales, 
then click on [OK] 
automatically build a 
formula 

 
Press  to accept the 

formula 

 
Repeat the above steps 
to create the formulas 
as follows: 

Cell Formula 

C10 =UK_Sales 

D10 =NZ_Sales 

 

1 

2 

For Your Reference… 

To paste defined names into a formula: 

1. Click in the cell where you want the formula 

2. Click on the Formulas tab, then click on Use 
in Formula in the Defined Names group  

3. Click on Paste Names, then click on the 
desired name 

Handy to Know… 

 You can press  to display the Paste Name 

dialog box. 

5 
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DEFINING NAMES FOR CONSTANT VALUES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
Defined Names_7.xlsx... 

 
On the Past 5 years 
worksheet, click in cell 
F5, type Tax, then press 

 

 
Click on the Formulas 
tab, then click on Define 
Name in the Defined 
Names group to see the 
New Name dialog box 

 
Type TaxRate in Name, 

then press  until 

Refers to is selected 

 
Type 10%, then click on 
[OK] 

 
In cell F6 type 
=E6*TaxRate 

Notice how the name 
appears in a list of 
constants as you type… 

 
Press  to complete 

the formula 

 
Click in cell F6 again, 
then click and drag the fill 
handle down to cell F10 

Each formula in the filled 
cells will use the constant 

 

If you have key values in your formulas that are 
unlikely to change, you can create a name to 
represent a value rather than a cell reference. 
This type of value is known as a constant 

because it doesn’t need to be changed. Constants 
are defined in the same way as normal range 
names, except that they are not directly entered 
into a cell in the workbook. 

1 

3 

For Your Reference… 

To create a defined name for a constant value: 

1. Click on the Formulas tab, then click on 
Define Name in the Defined Names group 

2. Type the name for the constant 

3. Replace the address in Refers to with a 
value 

Handy to Know… 

 One advantage of creating a name for a 
value is that the value is not easily 
accessible, and therefore has some 
protection. To display the value in a 
worksheet, use the name of the constant in a 
formula, and format it to your requirements. 

For example, =TaxRate. 

5 
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CREATING NAMES FROM A SELECTION 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

There will be times in a workbook when you have 
a whole lot of labels that are used to describe the 
contents of the adjacent cells. When this occurs 
you can select the cells and get Excel to pick up 

the labels and assign them as defined names to 
the cells to the right (the most common), the left, to 
the top, or to the bottom of the labels. 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
Defined Names_8.xlsx... 

 
Click on the Australia 
worksheet tab, then select 
the range A7:B11 

The range must include a 
series of labels and this 
one does, in column A… 

 
Click on the Formulas tab, 
then click on Create from 
Selection in the Defined 
Names group to display 
the Create Names from 
Selection dialog box 

 
Ensure that Left column 
is ticked (because that is 
where the labels are), then 
click on [OK] 

 
Click on the Name box 
drop arrow to see the new 
names 

 
Repeat the above steps 
for the following ranges: 

Worksheet Range 

United Kingdom A7:B11 

New Zealand A7:B11 

 
Click on the Name box 
drop arrow, then click on 
Edgecliff_Cellars to 
navigate to that range 

 

1 

2 

For Your Reference… 

To define names from a selection: 

1. Select the range (including the labels) 

2. Click on the Formulas tab, then click on 
Create from Selection in the Defined 
Names group 

3. Specify the label location and click [OK] 

Handy to Know… 

 The Create from Selection command is 
typically used where the labels are in the first 
column and values are in the second. You 
must ensure that the labels are somewhere 
in the selected range. 

4 
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SCOPING NAMES TO A WORKSHEET 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Unless otherwise specified, defined names are 
scoped to the entire workbook. This means that 
range names can be accessed from any 
worksheet in the workbook. You can also scope 

range names to the worksheet. This means that a 
range name will only be available to the worksheet 
in which it was created. 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
Defined Names_9.xlsx... 

 
Click on the Australia 
worksheet tab 

 
Click in cell B7, hold 
down , then click in 

cell B11 

 
Click on the Formulas 
tab, then click on Define 
Name in the Defined 
Names group to display 
the New Name dialog 
box 

 
Type Account_Value in 
Name 

 
Click on the drop arrow 
for Scope to see the 
current worksheet names 

 
Select Australia, then 
click on [OK] 

The name Account_Value 
should appear in the 
Name box… 

 
Click on the United 
Kingdom worksheet tab, 
then click on the Name 
box drop arrow  

Account_Value will not 
appear because it has 
been scoped to the 
Australia worksheet 

 

3 5 

For Your Reference… 

To scope a defined name to a worksheet: 

1. Select the range in the worksheet 

2. Click on the Formulas tab, then click on 
Define Name in the Defined Names group  

3. Click on the drop arrow for Scope, then click 
on the worksheet name 

7 

Handy to Know… 

 Normally you can’t have duplicate range 
names in a workbook. Since worksheet 
range names are scoped only to a worksheet 
it is possible to have the same range name 
duplicated across several of the worksheets. 
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USING THE NAME MANAGER 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once you have several defined names in a 
workbook, management of those names 
becomes crucial. There will be times when you 
want to redefine a name, delete redundant 

names, or just see what is available. Fortunately, 
Excel’s Name Manager allows you to do all of 
these things plus more. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file Defined 
Names_10.xlsx... 

 
Click on the Formulas tab, 
then click on Name 
Manager  in the Defined 
Names group to see the 
Name Manager dialog box 

 
Spend a few moments 
scrolling through the list to 
see what is there 

 
Click on Dodgy_Bros in 
Name, then click on 
[Delete] 

 
Click on [OK] to confirm the 
deletion 

 
Click on Fabulous_Forties 
in Name, then click on [Edit] 
to display the Edit Name 
dialog box 

 
Type Fabulous_Forty in 
Name, then click on [OK] to 
change the name of the 
range name 

 
Click on [Filter], then click 
on Names Scoped to 
Worksheet to see only the 
names scoped to 
worksheets 

 
Click on [Close] 

 

1 
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For Your Reference… 

To using the Name Manager for defined names: 

1. Click on the Formulas tab, then click on 
Name Manager in the Defined Names 
group 

2. Use the Name Manager  to delete, edit and 
filter the range names as appropriate 

Handy to Know… 

 Be careful of the filter because it is a 
compound filter. Each time you choose a 
filter option it builds from the previous filter to 
further refine your search. If you no longer 
want to work with a filtered names list, use 
the Clear Filter option to clear the filter out. 
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DOCUMENTING DEFINED NAMES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

The job’s not done till the paperwork’s finished – 
or so the saying goes. Excel allows you to paste 
a list of all defined names and their locations into 
the workbook. This provides an invaluable 

documentation tool so that you, and other users, 
can see what defined names are in the workbook 
and what ranges they refer to. 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
Defined Names_11.xlsx... 

 
Click on the New sheet 
icon at the bottom of the 
workbook to create a new 
worksheet 

It is best if documenting is 
done in a new 
worksheet… 

 
Click on the Formulas 
tab, click on Use in 
Formula in the Defined 
Names group, then click 
on Paste Names to see 
the Paste Name dialog 
box 

 
Click on [Paste List] to 
paste a list of range 
names into the worksheet 

 
Double click on the border 
between the headings for 
columns A and B to best 
fit column A 

 
Click elsewhere in the 
worksheet to deselect the 
cells and see the changes 
more clearly 

 

2 

For Your Reference… 

To paste a list of defined names into a 
worksheet: 

1. Click on the Formulas tab, then click on Use 
in Formula in the Defined Names group 

2. Click on Paste Names 

3. Click on [Paste List] 

Handy to Know… 

 Be careful when creating a defined name list 
as only those defined names scoped to the 
workbook will be listed. Defined names 
scoped to worksheets do not appear in the 
list. 

3 

5 
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NOTES: 
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CHAPTER 4 LOOKUP FUNCTIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of data lookup functions 

 learn how to use the CHOOSE function 

 learn how to use VLOOKUP 

 learn how to use VLOOKUP for exact matches 

 learn how to use HLOOKUP 

 learn how to use INDEX 

 learn how to use the MATCH function 

 gain an understanding of reference functions 

 learn how to use ROW and ROWS 

 learn how to use COLUMN and COLUMNS 

 learn how to use ADDRESS 

 learn how to use INDIRECT 

 learn how to use OFFSET. 

Excel provides a number of functions that allow you to look up and 
extract data from a list or table. These are known as Lookup 
functions and they can be used for a variety of purposes, such as: 

 returning the appropriate tax rate based on salary 

 returning the data that is at, say, the second column, third 
row of a table 

 returning the description, price and discount rate of an item, 
based on its code in the data inventory. 

 

INFOCUS 
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UNDERSTANDING DATA LOOKUP FUNCTIONS 
 

 

 

 

  

 

Data lookup functions are used to retrieve data 
from a table. They generally require at least two 
pieces of information; what to look for and where 
to look for it. The what to look for part is often 

part of a table of information which can be referred 
to as a calculation area. The where to look for it is 
known as a data table – a table in which a list of 
rates, figures, text or other items are held. 
 

Data Area 

The data area is often on a worksheet by itself, protecting it 
from accidentally being modified or deleted. It holds all of the 
possible values for the data. The values are laid out in a table 
format and they are listed in numerical or alphabetical order 
of the code that the lookup function will search for. 

In this example, we have created the name Pay_Rates for 
the range B3:C7 that holds the data. The resulting formula in 
the calculation area will be easier to understand. 

Calculation Area 

The calculation area is usually on a worksheet 
separate to the data area, unless you require the 
data values to be visible as well as the resulting 
calculations. 

The calculation area uses a formula, such as 
VLOOKUP, to find the correct data for each 
situation. In this example, the VLOOKUP function 
shown is comparing the value in cell C5 with the 
values in the range Pay_Rates. It then returns 
the value in the second column of the data table, 
determined by the 2 in the formula. 
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USING CHOOSE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The CHOOSE function is designed to allow you 
to choose an option from a list of items. It takes 
the format of CHOOSE(lookup-value, list of 
items) where the lookup-value indicates the 

position in the list of the item you want, that is, 1 
being the first item in the list and so on. Range 
names are often used for the list items to make the 
function easier to read and comprehend. 

Try This Yourself: 
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Before starting this 
exercise you MUST open 
the file Lookup 
Functions_1.xlsx... 

 
On the Payroll Tables 
worksheet tab, click  on the 
drop-arrow of the Name 
Box, then select Rate_1 

The hourly payroll rates 
have been placed on the 
Payroll Tables worksheet 
and each rate has been 
given a separate name… 

 
Click on cell C4 to see that 
the second rate has been 
named Rate_2 

 
Click on the Payroll 
worksheet tab, then click in 
cell D5 

We’ll use CHOOSE to look 
up the pay rate… 

 
Type 
=CHOOSE(C5,Rate_1, 
Rate_2,Rate_3,Rate_4,Ra
te_5) 

 
Press  

 
Click in cell D5, then click 
and drag the fill handle 
down to cell D13 

The hourly rates and the 
resulting calculated gross 
pay are now complete 

 

1 

For Your Reference… 

CHOOSE(index_num,value1,value2,...) 

This function selects a number, cell reference, 
defined name, formula, function, or text from a 
list of up to 254 different options. The 
index_num indicates which of the values to 
select, based on their position in the list. 

4 

Handy to Know… 

 When you set up a data area for the 
CHOOSE function, the labels or values to the 
left of the data play no particular role other 
than to describe the values listed. This is in 
contrast to other lookup functions which 
search the first column of a data table for a 
match. 

6 
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USING VLOOKUP 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

  

 

 

 

 

  

The classic lookup function is VLOOKUP – the 
vertical lookup. This function searches vertically 
down a sorted data table looking for a match with 
the lookup-value (or the next lowest value). It 

then looks across the table to the column you have 
specified to find the value to return. This is ideal for 
looking up numeric values within a range, such as 
tax rates, or commission amounts.  

Try This Yourself: 

S
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 Continue using the previous file 

with this exercise, or open the 
file Lookup Functions_2.xlsx... 

 
Click on the drop arrow for the 
Name Box, then select 
Tax_Table 

This is the data table for our 
VLOOKUP function… 

 
Click on the Payroll worksheet 
tab, then click in cell G5 

 
Type 
=VLOOKUP(F5,Tax_Table,2) 

 
Press  

0% appears because the 
Gross Pay is less than $500… 

 
Double-click on the fill handle 
in cell G5 to copy the formula 
down 

 
In cell H5 enter the formula 
=F5*G5, then double-click on 
the fill handle to copy the 
formula down 

 
In cell I5 enter the formula =F5-
H5, then double-click on the fill 
handle to copy the formula 
down 

 
Click in cell C10, then type 2 

and press  

Notice the change in the Pay 
Scale for Alana Keane results 
in changes to the Hourly Rate, 
Gross Pay, Tax Rate, Tax and 
Net Pay  

 

3 
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For Your Reference… 

VLOOKUP(lookup_value,table,col_index_num) 

This function searches down the left-most 
column of the table until it finds the lookup-
value or the row with the next lowest value. It 
then refers to the column index number 
nominated in the function, and returns the value 
found in the corresponding row and column. 

Handy to Know… 

 An alternative to the VLOOKUP function is 
the horizontal or HLOOKUP function. This 
looks for a value in the top row of a table or 
array of values, and returns the value from 
the same column in the row you specify. 

8 
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USING VLOOKUP FOR EXACT MATCHES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Generally, the VLOOKUP function uses three 
arguments: the lookup-value, the table location 
and the column number. This lookup will find a 
row based on a numeric range. However, you 

may only want to return a value if you get an exact 
match, and the optional fourth argument, match-
type, makes this possible. By adding FALSE to the 
function, #NA is returned if a match isn’t found.  

Try This Yourself: 
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Continue using the previous 
file with this exercise, or 
open the file Lookup 
Functions_3.xlsx... 

 
Click on the drop arrow for 
Name Box, then select 
Items_List 

This lookup table includes 
specific product codes that 
require an exact match… 

 
Click on the Invoice 
worksheet tab, then click in 
cell C7 

We’ll use the exact lookup 
to find the description… 

 
Type =VLOOKUP 
(B7,Items_List,2,FALSE) 

 
Click in cell E7, type 
=VLOOKUP(B7,Items_List

,3,FALSE), then press   

 
Click in cell F7, type 
=IF(ISBLANK($B$3),0, 
VLOOKUP(B7,Items_List,
4, FALSE)), then press 

  

 
Click in cell G7, type 
=(D7*E7)*(1-F7), then 

press   

 
Copy the formulas in 
columns C, E, F and G 
down to Row 10 to 
complete the invoice, as 
shown 

 

3 

For Your Reference… 

To use VLOOKUP for exact matching: 

VLOOKUP(lookup_value,table,col,range_lkup) 

Use the value of FALSE for range_lkup when 
you want to ensure exact matches only. #NA 
will be returned if an exact match isn’t found. 

Handy to Know… 

 You can use the ISNA(value) function to trap 
#NA results. For example, the structure 
=IF(ISNA(lookup),“Code not found”,lookup) 
will display a useful message when an exact 
match is not possible, rather than #NA which 
does not explain the problem clearly. 

7 
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USING HLOOKUP 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or 
open the file Lookup 
Functions_4.xlsx... 

 
Click on the Index 
worksheet tab, then click in 
cell D14 and examine the 
formula 

This is an example of the 
VLOOKUP function. This 
scans down the list of 
options looking for the 
corresponding Equipment 
number. When it finds a 
match, it returns the 
description. 

You can use HLOOKUP in 
a similar way… 

 
Click in cell D15, then type 
=HLOOKUP(C15,Rate_Typ
e,2,TRUE) 

 
Press  

The name of the Rate Type 
will be returned and 
displayed… 

 
Experiment with different 
values in cells C14 and C15 

You’ll find that the formulas 
return the corresponding 
descriptions 

 

For Your Reference… 

HLOOKUP(lookup_value,table,row_index_num) 

This function searches across the top-most 
column of the table until it finds the 
lookup_value or row with the next lowest value. 
It refers to the row index number nominated in 
the function, and returns the value found in the 
same column and corresponding row. 

Handy to Know… 

 If the lookup_value is smaller than the 
smallest value in the first row of table, 
HLOOKUP will return the #N/A error value. 

 Range_lookup is an optional argument. If 
TRUE or omitted, it will find the closest 
match in the top row. FALSE forces an exact 
match. 

  

Another commonly used lookup function is 
HLOOKUP – the horizontal lookup. This 
function searches horizontally across a sorted 
data table looking for a match with the lookup-

value (or the next lowest value). It then looks down 
the table to the row you have specified to find the 
value to return. This can be used to search for text, 
numbers, or logical values. 

2 
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USING INDEX 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
Lookup Functions_5.xlsx... 

 
Click on the drop arrow for 
the Name Box, then select 
Rate_List 

This will take you to the 
lookup table which shows 
the various hire rates for 
communications 
equipment… 

 
Click in cell C18 and type 
=INDEX(Rate_List,C14,C1
5) 

 
Press  

This will vary depending 
upon which figures appear 
in cell C14 and cell C15... 

 
In cell C19, type =C16*C18, 

then press  

The function has looked up 
the figure for the equipment 
type for the rate, and has 
returned the value. The 
total multiplies the number 
of days hire by the hire rate 
to give the Total Hire cost… 

 
Click in cell C14, type 1, 
then press  

The value returned is that 
for equipment type 1 with 
the given rate type 

 

The INDEX function is used to look up values 
according to specific row and column locations. 
The function requires the location of the lookup 
table, and the row and column to look in. This is 

especially useful for two-dimensional tables where 
you want the lookup values to be visible. For 
example, you may want alternative prices to be 
visible with your price calculator. 

2 
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For Your Reference… 

INDEX(array,row,column) 

This function goes to the table at the array or 
range specified and returns the value found in 
the specific row and column of the table. 

Handy to Know… 

 The INDEX function can also be used for 
multiple tables, where it takes the form: 

INDEX(reference,row,column,area). 

 Here reference refers to one or more 
ranges, and area refers to which of these 
ranges to look in for the value. 

4 
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USING MATCH 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The MATCH function looks for an item in a list 
and returns the position of that item. MATCH is 
used instead of the other lookup functions when 
the position of the item rather than the item itself 

is needed. For example, you can search for a 
particular category name in an alphabetical list and 
return its location in the list, such as 3 for the 3rd 

position or 4 for the 4th position. 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file Lookup 
Functions_6.xlsx... 

 
On the Index worksheet, click 
in cell C18 and examine the 
formula 

At the moment, the formula 
uses the Rate Type in cell 
C15 to determine which 
column to look in. Using 
MATCH you can allow the 
user to type the rate name 
rather than a number... 

 
Click in cell C15 and type 
Staff, then press  and 

delete the contents of cell D15 
which will display an error 

 
Click in cell C18 to display the 
formula in the Formula Bar, 
then double-click in cell C15 in 
the formula to select it  

We’ll replace it with the 
MATCH function… 

 
Type MATCH(C15,C4:F4) 

 
Press  

The formula looks up the text 
and returns its position, which 
is 4 in this case. This is, in 
turn, used by the INDEX 
function to locate the correct 
hire rate for the given rate 
type 

 

4 
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For Your Reference… 

MATCH(lookup_value,table,match_type) 

This function searches through the table until it 
finds the lookup_value or the row with the next 
lowest value. It returns the position of the value 
in the array. Match_type can be 1 (find value 
less than or equal to lookup_value), 0 (exact 
match) or -1 (value greater than or equal to). 

 

3 

5 

Handy to Know… 

 When MATCH searches for a text value, it 
expects to find the list in alphabetical order. If 
it doesn’t find an exact match in the 
alphabetical search, it will return the position 
of the word that would have appeared 
alphabetically before it in the list. This can be 

varied by changing match-type. 
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UNDERSTANDING REFERENCE FUNCTIONS 
 

 

 

 

  

 

Reference functions are functions that work 
with cell, row, column and range references. 
They are used to locate cells or ranges, or to 
identify independently the row of a cell or the 

column of a cell. Mostly, they are used for quite 
advanced formulas and so it is important that you 
have an understanding of how they work and what 
the term cell reference really means. 

Cell References 

You are probably comfortable referring to a cell by its cell reference which is a combination of row and 
column reference, for example, B1. The B refers to column B and the 1 refers to row 1. Behind the 
scene, Excel converts the column reference to the numerical equivalent, so, for example, the contents of 
cell B1 would be found in column 2, row 1. Some people even like to use the format R1C2, where this 
reference reads as row 1 column 2. 

Reference Functions 

Reference functions work with the parts of cell references, such as the row reference, or with 
complete cell references so that they can locate data or return information about or from cells. 
Here is a simple example of some reference functions and an explanation in the table below. 

 

 
ROW Returns the row number of a reference. In the example above, ROW() returns the 

current row number which is 3. 

COLUMN Returns the column number of a reference. In the example above, COLUMN() 
returns the current column number which is 5. 

ADDRESS Returns a reference as text to a single cell in a worksheet. In the example above, 
ADDRESS uses the row number in E3 (3) and the column number in E4 (5) to 
construct the cell address $E$3. 

INDIRECT Returns a reference indicated by a text value. This is often used in conjunction 
with ADDRESS to return the value from a specific cell reference created by 
ADDRESS. In the example above, INDIRECT refers to the text address created by 
ADDRESS in E5, then looks in the cell $E$3 and returns the contents which is 3. 

OFFSET Returns a reference offset from a given reference. In the example above, OFFSET 
looks at cell E5, then goes to the cell one above (-1) and in the same column (0) 
and returns the contents which is 5. 

ROWS Returns the number of rows in a reference. 

COLUMNS Returns the number of columns in a reference. 

AREAS Returns the number of non-contiguous areas in a range. Used for sophisticated 
programming. 

TRANSPOSE Returns a vertical array of cells as a horizontal array or vice versa. Used for 
sophisticated programming. 

. 
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USING ROW AND ROWS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
p

e
n

 

F
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e
 Before starting this exercise 

you MUST open the file 
Lookup Functions_7.xlsx... 

 
On the ADDRESSES 
worksheet, click in cell A1, 
type =ROW() and press  

 
Click in cell A1, then drag the 
fill handle down to cell A9 

This copies the formula down 
and gives you row numbering. 
What if you insert a row? 

 
Click on the row header for 
row 5, click on the Home tab, 
then click on Insert in the 
Cells group  

The numbers automatically 
adjust... 

 
Copy the formula in cell A4 
down to cell A5 to complete 
the numbering 

 
Click in cell A12, type 
=ROWS(A1:A10), then press 

 

This counts the number of 
rows in the range that you’ve 
specified, whether or not they 
have any contents 

 

For Your Reference… 

ROW(reference) 

This function returns the row number of the 
reference. The reference is optional. 

ROWS(reference) 

This function returns the number of rows in the 
reference. 

Handy to Know… 

 The ROW and COLUMN functions are often 
used together to create a complete cell 
reference. 

The ROW function returns the row number of a 
reference. The ROWS function, on the other 
hand, returns the number of rows in a reference. 
You can use ROW to create row numbering, or in 

conjunction with other functions, such as 
ADDRESS, to construct cell addresses from 
information located in other parts of a spreadsheet. 

1 

3 

5 
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USING COLUMN AND COLUMNS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
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e
 

Continue using the 
previous file with this 
exercise, or open the file 
Lookup Functions_8.xlsx... 

 
Ensure the ADDRESSES 
worksheet tab is selected 

 
Click in cell B1 and type 
=COLUMN(), then press 

 

 
Click in cell B1, then drag 
the fill handle across to cell 
F1 to copy the formula 

Like rows, this returns the 
column number of the cell 
in which it resides... 

 
Click in cell B12 and type 
=COLUMNS(A1:F1), then 
press  

Excel counts 6 columns in 
this range 

 

For Your Reference… 

COLUMN(reference) 

This function returns the column number of the 
reference. The reference is optional. 

COLUMNS(reference) 

This function returns the number of columns in 
the reference. 

Handy to Know… 

 COLUMN() returns the column number 
rather than the letter that we would usually 
use to refer to a column. Excel is able to 
interpret this number via other formulas to 
work out which column to look in. 

The COLUMN function returns the column 
number of a reference. The COLUMNS function, 
on the other hand, returns the number of columns 
in a reference. COLUMN can be used to create 

column numbering or used in conjunction with other 
functions, such as ADDRESS and INDIRECT, to 
enable access to specific cells in a worksheet. 

2 

3 

4 
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USING ADDRESS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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Continue using the previous 
file with this exercise, or 
open the file Lookup 
Functions_9.xlsx... 

 
On the ADDRESSES 
worksheet, click in cell B2, 
type =ADDRESS($A2,B$1,4)  
then press  and click 

back in cell B2 

This formula creates the cell 
reference from the row 
number in cell A2 and the 
column number in cell B1. 
The partial absolute 
addresses are used in the 
formula to allow it to be 
copied to the rest of the 
table... 

 
Using the fill handle, drag the 
formula down to row 10, then 
across to column F 

This calculates the cell 
address of each cell from the 
row and column addresses in 
column A and row 1... 

 
Click elsewhere in the 
spreadsheet to see the result 

 

For Your Reference… 

ADDRESS(row_num, col_num) 

This function creates a text version of a cell 
reference from the row_num and col_num. By 
default it creates an absolute cell reference, but 
this can be altered by using the optional 
parameter abs_num where 1=absolute, 
2=absolute row, 3=absolute column, 4=relative. 

The ADDRESS function creates a text version of 
a cell address from a given row number and a 
given column number. It’s often used in 
conjunction with ROW and COLUMN, where 

ROW and COLUMN retrieve the two parts of the 
cell reference separately. ADDRESS combines a 
row reference and a column reference to create a 
cell reference. 

1 

2 

Handy to Know… 

 ADDRESS has three optional parameters 
which are abs_num, r1 and sheet_text 
respectively. If r1 is FALSE, it gives a R1C1 
style reference. Otherwise, it is A1. 
Sheet_text is the text to be used as the 
worksheet name. It appears before the cell 
reference in the cell. 

3 
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USING INDIRECT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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 Continue using the previous file 

with this exercise, or open the 
file Lookup Functions_10.xlsx... 

 
Click on the INDIRECT 
worksheet tab, then click in cell 
E3 

This includes property prices as 
well as the maximum, minimum 
and median house prices. The 
list of sales prices is named 
Sales_Figures... 

 
Click in cell F3, type 
=ADDRESS(MATCH(Top_Pric
e,Sales_Figures,0) + 
ROW(B2),COLUMN(B2)) then 
press  and click in cell F3 

This tells you that the top price 
is in $B$11. We need the 
property’s address which is in 
the cell one to the left... 

 
Click in front of ADDRESS in 
the Formula Bar and type 
INDIRECT( 

 
Press  to move to the end of 

the formula, then edit as shown 

 
Press , then in F4 type 

=INDIRECT(ADDRESS(MATC
H(Min_Price,Sales_Figures,0) 
+ ROW(B2),COLUMN(B2)-1)) 
and press  

Now the address of the 
minimum price house is also 
visible 

 

For Your Reference… 

INDIRECT(ref_text) 

Retrieves the contents of the cell with the 

address ref_text. 

The INDIRECT function returns the reference 
specified by a text string. Often the text string is 
provided by the ADDRESS function or the ROW 
and COLUMN functions. When the reference is 

returned, the contents of the referenced cell are 
displayed. This means that INDIRECT is often used 
to retrieve the contents of a cell located by another 
function, such as the MAX or MIN. 

3 

Handy to Know… 

 By default, INDIRECT expects an A1 format 
cell reference. To use a R1C1 style 
reference, use the optional parameter a1. 
For example, INDIRECT(“B3”,TRUE) and  
INDIRECT(“R3C2”, FALSE) will both return 
the contents of B3. 

4 

5 
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USING OFFSET 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
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 Continue using the 

previous file with this 
exercise, or open the file 
Lookup 
Functions_11.xlsx... 

 
Click on the OFFSET 
worksheet tab, then click 
in cell F3 

 
Type 
=OFFSET(INDIRECT( 
ADDRESS(MATCH( 
Max_Read,Readings,0)+ 
ROW(B3),COLUMN(B3))
) 
,0,-1)  
then press  

 
In cell F4 type 
=OFFSET(INDIRECT( 
ADDRESS(MATCH( 
Min_Read,Readings,0)+ 
ROW(B3),COLUMN(B3))
) 
,0,-1) 
then press  

 

For Your Reference… 

OFFSET(reference, rows, cols) 

This function goes to the cell reference, then 
moves down the number of rows and across 
the number of columns specified, then retrieves 
the data in the cell or range it locates. 

The OFFSET function is used to retrieve a cell or 
range that is a specified number of rows and/or 
columns from a given cell or range of cells. It is 
great for locating information in a list when you 

know where the data will be positioned in relation to 
other figures with a known location. OFFSET can 
return a single cell or a range of cells. 

1 

Handy to Know… 

 The additional optional parameters height 
and width determine how many cells are 
returned by the OFFSET function. For 
example, OFFSET(B3,2,1,2,2) will retrieve 
the range C5:D6. In this case, it is often used 
with SUM to calculate the total of these cells. 

2 

3 



Microsoft Excel 2016 - More Functions 

© 2017 The University of Nottingham Page 51 Chapter 5 - Information Functions 

CHAPTER 5 INFORMATION FUNCTIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of Information functions 

 learn how to use the CELL function 

 learn how to use the ISBLANK function 

 learn how to use the ISERR function 

 learn how to use the ISODD and ISEVEN functions 

 learn how to use the ISNUMBER and ISTEXT functions 

 learn how to use the TYPE function. 

The Information functions provided with Excel enable you to retrieve 
information related to specified cells. They are useful for testing 
data prior to using it further in a worksheet. 

INFOCUS 
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UNDERSTANDING INFORMATION FUNCTIONS 
 

 

 

 

  

 

There are seventeen information functions 
provided in Excel that can be used to return 
information about any specified cell. Most of 
these functions are IS functions which test if 

specific conditions exist in a cell. The information 
functions are of importance for users who share 
their spreadsheets with colleagues using earlier 
versions of Excel. They are listed below. 

Information Functions List 

The Information functions, although seemingly basic, are best used in conjunction with other functions 
such as IF. As a part of an IF function, the Information functions can test the value of a cell when that 
value determines the action of the function. For instance, depending on the value of a cell (text, numeric, 
date etc.), you might want Excel to apply different formatting. 

For more information on each of the Information functions, refer to the Home page of Excel Help and 
click on Function reference. Click on the link for Information functions to see the functions list. As 
some of the functions can return a variety of numeric or text codes, a listing of these codes is also 
available here, by clicking on the function name 

CELL ISEVEN ISREF 

ERROR.TYPE ISLOGICAL ISTEXT 

INFO ISNA N 

ISBLANK ISNONTEXT NA 

ISERROR ISNUMBER TYPE 

ISERR ISODD  

 

 

Note: If you prefer to write functions using the Function Library on the Formulas tab, the Information 
Functions are located in More Functions. 
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USING THE CELL FUNCTION 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
p

e
n
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 Before starting this exercise 

you MUST open the file 
Information Functions_1.xlsx... 

 
Click on the CELL worksheet 
tab, then click in cell B5 

The CELL function can return a 
variety of information about a 
cell. In this example, we will 
use the list of information types 
to return different facts about a 
cell... 

 
Type =CELL(A5,$B$2) 

The value in column A is the 
information we want to return 
in relation to the content of cell 
B2... 

 
Press  to complete the 

formula 

The cell address is returned as 
$B$2... 

 
Click in cell B5, then double-
click on the fill handle to copy 
the formula down the table 

 
Click on a blank area of the 
worksheet to see the results 
more clearly 

 

For Your Reference… 

CELL(info_type, reference) 

 This function returns information relating to 
a specified cell. This can include information 
on cell formatting, location or contents. 

The CELL function is designed to return 
information relating to a specified cell. This can 
include information relating to the cell location, 
formatting, content or even the filename. If you 

indicate a specific cell, Excel will provide 
information relating to that cell. If you do not 
indicate a specific cell or range, Excel will refer to 
the cell that was last changed. 

2 

3 

Handy to Know… 

 When using the CELL function, info_type 
can produce a number of different results. 
For instance, type might return b (blank), v 
(value) or l (label). For more information on 
info_type options, click on Function 
reference on the Home page of Excel Help 

and navigate to Information function topics. 

5 
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USING THE ISBLANK FUNCTION 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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 Continue using the 

previous file with this 
exercise, or open the file 
Information 
Functions_2.xlsx... 

 
Click on the IS worksheet 
tab, then click in cell B2 

 
Type =ISBLANK(A2) 

This will test if cell A2 is 
completely empty... 

 
Press  to complete 

the formula 

As to be expected, the 
result is FALSE... 

 
Click in cell B2, then drag 
the fill handle down to cell 
B12 to copy the formula 
down the table 

 

For Your Reference… 

ISBLANK(value) 

 Checks the value of the specified cell and 
returns TRUE if empty. The function returns 

FALSE if the cell contains any content. 

There are a number of IS functions within the 
Information functions category in Excel. 
Generally, the IS functions test the condition of 
the contents of a cell and return a value based on 

the findings. The ISBLANK function tests whether 
the contents of a cell are completely blank – that is, 
is the cell completely empty. If the cell is empty, 
this function will return the value TRUE. 

2 

Handy to Know… 

 When using the ISBLANK function, a 
FALSE result will occur even if the cell 
contains a single space character or an 
apostrophe. 

3 

4 
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USING THE ISERR FUNCTION 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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 Continue using the 

previous file with this 
exercise, or open the file 
Information 
Functions_3.xlsx... 

 
Ensure that the IS 
worksheet is currently 
active, then click in cell 
C2 

 
Type =ISERR(A2) 

 
Press  to complete 

the formula 

 
Click in cell C2, then 
double-click on the fill 
handle to copy the 
formula down the table 

 

For Your Reference… 

ISERR(value) 

 Checks for any errors, except #N/A and 
returns the logical value TRUE. FALSE is 
returned for the error #N/A and any other 
value. 

The ISERR function enables you to determine 
whether a calculation or a cell’s content will 
return one of Excel’s built-in errors. These errors 
include #NULL!, #VALUE!, #NAME? and the 

like. Whereas the ISERROR function reports on all 
errors, ISERR reports on all errors except #N/A. 
Both functions are handy when used with an IF 
function to detect errors in formulas. 

2 

Handy to Know… 

 The ISERR and ISERROR functions are left 
over from earlier versions. The IFERROR 
function should be used in Excel 2007 or 
newer. However, if you need to share 
information with users of earlier versions, you 
should continue to use the ISERR and 

ISERROR functions, combined with IF. 

3 

4 
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USING THE ISODD AND ISEVEN FUNCTIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
5 

Try This Yourself: 

S
a

m
e

 

F
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Continue using the previous 
file with this exercise, or 
open the file Information 
Functions_4.xlsx... 

 
Ensure that the IS worksheet 
is currently active, then click 
in cell D2 

 
Type =ISODD(A2) 

 
Press  to complete the 

formula 

A TRUE value is returned as 
cell A2 contains the value 1, 
which we know to be an odd 
number... 

 
Click in cell D2, then double-
click on the fill handle to copy 
the formula down the table 

 
Click in cell E2 and type 
=ISEVEN(A2) 

 
Press  to complete the 

formula 

 
Click in cell E2, then double-
click on the fill handle to copy 
the formula down the table 

 

For Your Reference… 

ISODD(number) 

 Checks the value of a cell and returns TRUE 
if the value is an odd number. 

ISEVEN(number) 

 Checks the value of a cell and returns TRUE 
if the value is an even number. 

The ISEVEN and ISODD functions enable you to 
determine whether a value contained in a cell is 
even or odd – that is, whether it is evenly divisible 
by 2 or not. If the cell is empty, the content is 

considered to be zero and will be reported as even. 
If a cell contains a date, text or a logical value, then 
an error or a value that does not make sense will 
be returned. 

2 

Handy to Know… 

 Values containing decimal places are 
ignored by both the ISODD and ISEVEN 
functions. For instance, 1.2 and 1.3 would 
both return TRUE for the ISODD function, 
and 2.33 and 2.44 would both return TRUE 
for the ISEVEN function. 

4 

7 
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USING THE ISNUMBER AND ISTEXT FUNCTIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Information 
Functions_5.xlsx... 

 
Ensure that the IS 
worksheet is currently 
active, then click in cell 
F2 

 
Type =ISNUMBER(A2) 

 
Press  to complete 

the formula 

 
Click in cell F2, then 
double-click on the fill 
handle to copy the 
formula down the table 

 
Click in G2 and type 
=ISTEXT(A2) 

 
Press  to complete 

the formula 

 
Click in cell G2, then 
double-click on the fill 
handle to copy the 
formula down the table 

 

For Your Reference… 

ISNUMBER(value) 

 Returns TRUE if the value is a number or a 
date. 

ISTEXT(value) 

 Returns TRUE if the value is text. 

The ISNUMBER function tests the contents of a 
cell and returns TRUE if the contents are numeric 
or a date. The ISTEXT function tests the contents 
of a cell and returns TRUE if the contents are 

text. As well as being useful in conjunction with the 
IF function, the ISNUMBER and ISTEXT functions 
are useful when applying conditional formatting to 
cells, to discriminate text and numeric content. 

2 

Handy to Know… 

 When used in conditional formatting, the 
ISTEXT function can assist in checking 
where numbers may have been entered 
inadvertently as text. 

5 

7 
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USING THE TYPE FUNCTION 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
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 Continue using the 

previous file with this 
exercise, or open the file 
Information 
Functions_6.xlsx... 

 
Click on the TYPE 
worksheet tab, then click in 
cell B2 

 
Type =TYPE(A2) 

 
Press  to complete the 

formula 

As cell A2 contains a 
number, Excel returns the 
value 1 – this is the code 
for a numeric type... 

 
Click in cell B2, then 
double-click on the fill 
handle to copy the formula 
down the table 

Notice that both numbers 
and dates are considered 
Type 1 

 

For Your Reference… 

TYPE(value) 

 Returns a type code, indicating the data type 

for a specified value. 

The TYPE function enables you to test the value 
of a cell and returns a code number to indicate 
the content type. For instance, a cell that 
contains text will return 2, whereas a cell that 

contains an error will return 16. The other numeric 
codes that are returned are: 1 for a numeric or date 
type, 4 for a logical type and 64 for an array type. 

2 

Handy to Know… 

 The TYPE function is useful for testing the 
value type of cell when this will impact on the 
behaviour of another function. 

3 

4 
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CONCLUDING REMARKS 

 

 

 

 

 

 

 

 

Congratulations!  

You have now completed Microsoft Excel 2016 - More Functions. Microsoft Excel 2016 - More 
Functions was designed to get you to the point where you can competently perform a variety of 
operations.  

We have tried to build up your skills and knowledge by having you work through specific tasks. 
The step by step approach will serve as a reference for you when you need to repeat a task. 

 

Where To From Here? 

The following is a little advice about what to do next: 

 Spend some time playing with what you have learnt. You should reinforce the skills that you 
have acquired and use some of the application's commands. This will test just how much of 
the concepts and features have stuck! Don't try a big task just yet if you can avoid it - small 
is a good way to start. 

 Some aspects of the course may now be a little vague. Go over some of the points that you 
may be unclear about. Use the examples and exercises in these notes and have another go 
- these step-by-step notes were designed to help you in the classroom and in the work 
place! 

Here are a few techniques and strategies that we've found handy for learning more about 
technology: 

 read computer magazines - there are often useful articles about specific techniques 

 if you have the skills and facilities browse the Internet, specifically the technical pages of 
the application that you have just learnt 

 take an interest in what your work colleagues have done and how they did it - we don't 
suggest that you plagiarise but you can certainly learn from the techniques of others 

 if your software came with a manual (which is rare nowadays) spend a bit of time each day 
reading a few pages. Then try the techniques out straight away - over a period of time 
you'll learn a lot this way 

 and of course, there are also more courses and books for you to work through. 

Hungry for More? 

We live in an ever-changing world where we all need to review and upgrade our 
skills. 

If you have received this course book on a training course why not ask the tutor or 
trainer for other courses that may be of benefit to you. If you are attending a 
college ask for one of their brochures. 

Alternatively, if you’ve enjoyed using this course book you can find others that 
cover a wide range of topics at our web site www.watsoniapublishing.com. 

 

http://www.watsoniapublishing.com/
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